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ま　え　が　き

大学などの工業数学を考えた場合，少なくとも二つの側面がある。その代表例は数

値ベースで計算することで，すべての数値が既知である Excelのような数値（numeri-

cal）計算である。他方は，ax2＋bx＋c＝0のような文字変数（symbol）を含みなが

ら数式を解くことである。後者の symbolic数学では，変数にある値を代入し，残り

は未知変数として変数名のまま数式展開を行い一般的に解析することができる。数値

のみを扱う電卓と似て非なるところである。Pythonでは，この二つの世界は整然と

区別され，numpyと sympyのコマンド群で実行する。両群のコマンドを協調させな

がら一つの目的に向かってプログラムが作成される。競合ソフトウェア Mathematica

も symbolic数学を得意とするが，無料という点で Pythonが多くの方に歓迎されてい

る。

板書で秩序立てて数式や数値を交えながら説明する理工系授業などでは，本ソフト

ウェアの利用で教育効率は各段に向上する。局所的ではあるが大学での理系工業数学

の教育方法が一変しつつある。また，Excelを駆使しているような職場でも，複素数

や変数を交えての計算なども簡単に扱える本ソフトウェアの導入は，仕事の仕方を変

貌させる可能性がある。

工場の設計者として効率向上至上主義を教え込まれ，教育者に転じた著者自身，こ

の Pythonを駆使した講義の高効率化が目下の自身の開発テーマである。例えば，理

工系力学において，数式・計算に悩まされることより，図表を用いてもっと上流側の

物理的考察や力学的解釈に注力した講義を展開したい。そのツールとして，Python 

をダウンロード（DL）し，それを活用する入門書を著した。

本書の構成は全 7章よりなる。

第 1章は，Pythonの DLおよびインストール方法の手引きである。

第 2章では，簡単な電卓計算から始まり，表計算，グラフの描画，ファイルの出し

入れなど通論で 10講義を用意。これがわかれば即実践へという入門編である。第 3章

では，フローチャートに似たソフトウェア設計図である PAD（Problem Analysis Dia-

gram）を紹介し，論理思考過程の視覚化を説く。第 4章では，厳選した 4 テーマ「微
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ii ま 　 え 　 が 　 き

分方程式，ラプラス変換，フーリエ変換，固有値問題」について，大学で学ぶ工業数

学を例題中心に学ぶ。鉛筆に代わり，ソフトウェアで数学を処理する威力を体感して

ほしい。以上の準備のもと，筆者らの専門範囲である機械・電気系ダイナミクスの基

本として「機械力学」（振動工学）を第 5章に，また「制御工学」を第 6章にそれぞ

れを述べた。最終第 7章では，我々が仕事や教育で使っている重宝な私設関数を紹介

するので，多いに活用されたい。

Pythonなどのソフトウェア習得のコツはプログラムのコピーにある。自分の課題

に近いプログラムをまずコピー，それを変形し，自分流に書き換えていく方法が最も

近道であることは，等しく余人の認めるところである。大いにコピーされたい。紙面

数の制約で本書では中途となったプログラムが多々あり，（詳細はWEB）のサインが

入っている。コロナ社のWebページ†にはプログラムの全文が載っているので，DL・

活用をお願いします。

書き終えてみると，ソフトウェア紹介本の執筆の大変さを思い知った。特にプログ

ラミングでは，間違いなきことは当然であるが，紹介コマンドの取捨選択，プロミン

グは短く・分かりやすくなど，推敲に推敲を重ねた。著者らの筆力の不足，浅学非才

や独断にもとづく誤った説明の所在が不安でもある。万全の体制で執筆につとめた

が，専門の範囲も広く，また奥も深く，山の高さを痛感している。読者の皆様の批判

や叱正を得ることができれば著者の望外の喜びとするところである。

最後に，本書の図版作成などでご便宜を賜った新川文登様（新川電機株式会社 社

長）および同社広報関係者の皆様のご協力に感謝申し上げます。また，出版に際し格

段のご支援を賜ったコロナ社に深く感謝の意を表す。

2023年 12月
著者代表　松下 修己

†　コロナ社Webページ　https://www.coronasha.co.jp/np/isbn/9784339032468/
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❶ 
Python 事始め

	 1・1	 	 Anaconda パッケージについて

本節では Pythonを使用するための準備について解説する。特に算術計算で使用す

るためには数多くのライブラリを準備する必要がある。本書では算術計算に必要なラ

イブラリや実行環境をまとめてインストールできる Anacondaというパッケージを

利用している。おもなライブラリとして，算術計算 Numpy，シンボリック変数計算

Sympy，グラフ描画matplotlib，実行環境 Jupyter Notebookなどが入っている。

機械・電機・制御などのシステム工学計算に必要なものがおよそそろっている。

	 1・2	 	 Anaconda のインストール

Anacondaのソフトウェアは下記の webサイト†からダウンロードできる。

https://www.anaconda.com/products/individual

上記サイトを表示したら，一番下までスクロールし，自分の OSに合わせてクリッ

クしてインストーラをダウンロード（DL）を実行すると実行環境ができる。本書で

はインストールの詳細は省略するが，下記のサイトで解説されているので，参考にさ

れたい。

https://www.python.jp/install/anaconda/windows/install.html

†　本書に示す URLはすべて 2023年 12月現在。
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2 1 .　 Python 事 始 め

	 1・3	 	 Jupyter ノートブックと実行方法

インストールが完了したら，プログラムの起動を確認する。図 1・1に示すように，

① のスタートメニューをクリックすると，② の Anaconda3のフォルダが見える。そ

のフォルダをクリックすると③のように中身のソフトウェアが見える。この中か

ら ④ の“Jupyter Notebook”を選択し起動する。

図 1・1　スタートメニュー

☜①

②☞

④

⇔

｛③
Jupyter Notebookは標準ブラウザ（Windowsのときは Edge）で動作するようになっ

ており，図 1・2（左上）は Jupyter Notebookが起動した直後の画面である。表示さ

れているフォルダはユーザーの“Home”フォルダであり，標準の Desktopなどのフォ

ルダが見えるはずである。ここから，⑤“Documents”，⑥“Python Scripts”と順に

クリックする。ここから既存のNotebookファイル⑦を選択して開くことができる。

ここでは，fujiwara.ipynbを選択している。既存ファイルがない場合は新規にプログ

ラムを書き始めるとして，右上に表示されている ⑧“New▼”をクリックする。そ

の後，⑨“Python3 （ipykernel）”メニューを選択すると新しく ⑩ Notebook“Untitle1.

ipynb”が開かれる。⑩ の Untitle1をクリックすると名前の変更ができる。この段階

で計算用の Notebookが準備され，⑪ ではプロンプトが点滅し入力のタイプインを

待っている。これで準備完了である。
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31 .4　 簡 単 な 計 算

これから計算を開始していく。In［ ］の右枠にカーソルが点滅するので，ここに

プログラムを記述して， SHIFT ＋ ENTER を押すと計算が実行される。この枠一つ

が実行単位となり，セル（cell）と呼ばれる。実行が完了すると直下に計算結果とし

て Out［ ］が現れる。［ ］内の数字はこの Notebookでセルが実行された順番であり，

数字が表示されていない場合は未実行，［*］が表示されているときは実行中であるこ

とを示す。

	 1・4	 	 簡 単 な 計 算

早速，実行してみよう。簡単な計算であれば，数値計算のライブラリを Importせ

ずに実行できるので，下記の例に従って進めてほしい。

〔 1〕足し算 ＋

・ 整数値 6＋3をセルに入力
　［Shift］＋［Enter］ を押す。
・結果 9が表示される。 Out [1]: 9

In [1]:

☜

図 1・2　Jupyter Notebookの起動直後の画面

fujiwara.ipynb

Python Scripts

Documents

新規Notebook☞

⑤

⑨

⑪

Python3 (ipykernel)

Untitled1

Untitled1

⑩

New ▼

New ▼

⑥

⑦

⑧

既存Notebook

プログラムを入力するセル
入力中，枠は緑色，Shift + Enter を押して実行する
実行後は青色に変化し結果のOut[]行が表示される

In [ ]

ファイル名変更可

起動
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4 1 .　 Python 事 始 め

〔 2〕引き算 －

・例 6 .0-3
・結果 3 .0

In [2]:

☜Out [2]: 3.0

〔 3〕掛け算 *，割り算 / と四則演算

加減乗除を使った練習をしてみよう。

・例 1＋2, 4-3, 4*6, 10/5
・ 複数行の結果を表示するときは

Print()Print()関数を使用
・結果 3,1,24,2 .0

Out [3]: 3          1 

In [3]:

☜

’*’(アスタリスク)

割り算 ‘/’ (スラッシュ)24       2.0

・例 1＋2×3×4－ 6÷3 ＝ 23
・結果 23 .0 Out [4]: 23.0

In [4]:
☜

〔 4〕割り算の商 // と除り ％

・例 7割る 3の商と除り
・結果 2,1 Out [5]: 2  1

In [5]:
☜

’//’(スラッシュ,スラッシュ)

除り ‘%’ 

〔 5〕べき乗 **

・例 28

・結果 256
Out [6]: 256

In [6]: ☜

’**’(アスタリスクアスタリスク)

	 1・5	 	 メニューの活用

記載したプログラムの保存や暴走したプログラムの中止などはメニューから選択す

る。図 1・3におもなものを記載する。

①　実行したファイルのオープンと保存

①（ a）　既存のファイルを開くとき　　File → Open
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51 .5　 メニューの活用

①（ b）　保存するとき　　File → Save and Checkpoint　または

①（ c）　保存アイコンを押す

②　セルの操作

既存のファイルを開いた直後などにすべてのセルを実行するときは

②（ a）　Cell → RunAll

プログラムの区切りとしてタイトル，コメントを入れる場合はセルを選択した

状態で

②（ b）　Cell → Cell Type → Markdown

を選ぶ。文字の先頭に ʻ#ʼ を付けてから，［SHIFT］＋［ENTER］を押すと文字列が

フォントの大きいゴシック体で表示される。先頭 #の数を ʼ##ʼ と増やすとフォン

トが小さくなっていく。

③　カーネル操作

何らかの理由でプログラムが止まったり，暴走したときは

③（ a）　Kernel → Restart

で，計算をリセットし，変数を初期化する。また，プログラム全体を始めから終

図 1・3　Jupyter notebookのメニューと操作

①(a)

③(a)

①(b)
①(c)

②(b)

②(a)
③(b)
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索　　　　　引

索引は以下の順に掲載する。
1. 　コマンド一覧（計 115）　np.および sp.の後がアルファベット順に並んでいる。
ただし，私設関数 my_○○○○は第 7章 p. 177に掲載。

2. 　専門用語一覧（計 281）

1.　コマンド一覧

記号コマンド 解　説 掲載ページ
mat[mat[n]],  mat[:,mat[:,n]] 要素 matmatの n行目 /n列目を取り出す 30,  149

{a:X,b:Y}{a:X,b:Y} dict dict 辞書  {a:X,b:Y}{a:X,b:Y} 25

[a,b,c][a,b,c] list list リスト  [a,b,c][a,b,c] 24

{a,b,c}{a,b,c} set set セット  配列定義 26

(a,b,c)(a,b,c) tuple tuple タプル  (a,b,c)(a,b,c) 25

//// ,    %%  ,     **** 割り算の商，余り，べき乗 4

__（アンダーバー） 前の実行結果 13

++ ,  -- ,  ** ,  // 加減乗除 3,  4

i+=ai+=a,  ii--=a=a,   i*=a i*=a,  i/=ai/=a iiに aaを足す，引く，かける，割る 45

コマンド 解　説 掲載ページ
np.abs()np.abs(),  sp.Abs() sp.Abs() 絶対値 12,  75,  78,  

96,  104

np.angle(z)np.angle(z),  sp.arg(z)sp.arg(z) 複素数の位相角 12

sp.apart()sp.apart() 部分分数展開 121

list.append(a)list.append(a),  
np.append(list,a)np.append(list,a)

listlistに要素 aaを追加 72,  74

np.arange(ns,ne,nd)np.arange(ns,ne,nd) nsnsから neneまで ndnd刻みのベクトル作成 72,  134

np.array([1,2])np.array([1,2]) 数値リスト [1,2][1,2]を NumPy用行列定義 22,  46

Axes3D(fig)Axes3D(fig) 3Dグラフの描画準備 34

plt.bar(x,y)plt.bar(x,y) リスト x,yx,yを棒グラフで表示 45,  72

sp.BlockMatrix([[m1,m2],[m3,m4]])sp.BlockMatrix([[m1,m2],[m3,m4]]) 行列を組み合わせて大きな行列作成 31

np.conjugate(z)np.conjugate(z) 複素数の共役 85

np.cos(x)np.cos(x),  sp.cos(x)sp.cos(x) coscos関数 34,  71,  186

vec1.cross(vec2)vec1.cross(vec2) vec1vec1と vec2vec2の外積 28
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190 索 　 　 　 　 　 引

pd.DataFrame(dat)pd.DataFrame(dat) datdatを pandaspandas classに変更 38

def .... returndef .... return 私設関数定義 56

sp.deg(rad)sp.deg(rad),  np.deg2rad(deg)np.deg2rad(deg) radianを度に変換，度を radianに変換 12,  13

sp.Derivative(f(x),x).doit()sp.Derivative(f(x),x).doit() ffを xxで微分 20

sp.det(mat)sp.det(mat) matmatの行列式 164

np.diag([x1,x2,..])np.diag([x1,x2,..]) 対角行列 29,  119

sp.diff(f(x),x),sp.diff(f(x),x,2)sp.diff(f(x),x),sp.diff(f(x),x,2)
eq.diff(x)eq.diff(x)

ffを xxで微分，ffを xxで 2階微分
式 eqeqを xxで微分

20,  50

display()display() 数式，行列表示 13

np.dot(mat1,mat2)np.dot(mat1,mat2)
vec1.dot(vec2)vec1.dot(vec2)

行列の掛け算
ベクトルの内積

188
28

sp.dsolve()sp.dsolve() 微分方程式を解く 50

np.linalg.eig()np.linalg.eig() 固有値問題（固有値，固有ベクトル） 85

sp.Eq(siki)sp.Eq(siki) 方程式 sikisiki=0の定義 18,  50

np.exp(x)np.exp(x),  sp.exp(x)sp.exp(x) e^xe^x 9,  82,  97

sp.expand()sp.expand() 数式を展開 19,  52

zu1.extend(zu2)zu1.extend(zu2) sp.plotsp.plotの描画 zu1zu1にグラフ zu2zu2を重ねる 52,  67

sp.eye(n)sp.eye(n) nn×nnの単位行列 29

sp.factor(sp.factor(多項式 )),  f.factor()f.factor() 因数分解，多項式 ffの因数分解 19,  121,  163

np.fft.fft()np.fft.fft() 高速フーリエ変換 78,  128

np.fft.fftfreq()np.fft.fftfreq() 離散フーリエ用の周波数軸を設定 128

plt.figure(figsize=(3,3))plt.figure(figsize=(3,3)) 図のサイズ指定（横幅の最大値 10） 105

sp.flatten(mat)sp.flatten(mat) 多次元リストを 1次元に平坦化 165

float(x)float(x) xxを浮動小数点数として扱う 37

np.floor()np.floor() 数値の整数部分 79

sp.fourier_series(sp.fourier_series(関数 ).trun-).trun-
cate(n)cate(n)

関数の nn次までのフーリエ級数展開 72

sp.fraction()sp.fraction() 分数を（分子 [0]，分母 [1]）として出力 163,  188

f=sp.Function( )f=sp.Function( ) ffを関数として定義 56,  106

plt.grid()plt.grid() グラフの格子を ON，OFFする 75

sp.Heaviside()sp.Heaviside() ヘビサイド関数 63

ifif条件 :: 条件が真のとき，つぎの行を実行 46

x.imagx.imag,  sp.im(x)sp.im(x) 複素数 xxの虚部（npnpでは変数の後ろ
に .imag.imag）

11,  12,  178

int()int(),np.int64()np.int64() 整数指定，64ビット整数 79,  128
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191索 　 　 　 　 　 引

sp.integrate()sp.integrate() 積分 21,  134

np.linalg.inv(mat)np.linalg.inv(mat),  mat.inv()mat.inv() 行列 matmatの逆行列 90,  112

sp.inverse_laplace_transform()sp.inverse_laplace_transform() 逆ラプラス変換 66,  142

1j1j,  sp.Isp.I 虚数単位（npnpのときは 1j1jのように数字
必須）

11,  94,  146

len(vec)len(vec),len(mat)len(mat),len(mat[0])len(mat[0]) vecvecの要素数，matmatの行数，matmatの列数 30 

eq.lhseq.lhs,eq.rhseq.rhs 方程式 eqeqの左辺，右辺 50

sp.linsolve((mat,vec))sp.linsolve((mat,vec)) 線形代数式 mat*x=vecmat*x=vecの xxを解く 31

np.linspace(ns,ne,nd)np.linspace(ns,ne,nd) nsnsから neneまで ndnd刻みのベクトル作成 58,  82

np.log(x)np.log(x)
np.log2(x)np.log2(x),  np.log10(x)np.log10(x)

底が e（自然対数）
底が 2，10（常用対数）の対数

9

sp.log(x)sp.log(x),  sp.log(x,a)sp.log(x,a) 自然対数，底が aaの対数 10,  178

sp.Matrix(mat)sp.Matrix(mat) 行列定義 22,  121

sp.matrix_multiply_sp.matrix_multiply_
elementwise(v1,v2)elementwise(v1,v2)

v1v1と v2v2の要素同士の積 28

np.meshgrid(xx,yy)np.meshgrid(xx,yy) メッシュデータ作成→ plot_surfaceで描
画

34,  58

np.mod(a,n)np.mod(a,n) 数値 aaを除数 nnで割り算したときの余り 45

sp.N(x)sp.N(x) 数値で表現 8,  153

np.ones((n,m))np.ones((n,m)) 要素 1の nn行 mm列の行列 58

passpass ループをパスする 47

np.pinp.pi,  sp.pisp.pi 円周率 8

sp.plot(fx, (t,0,5) )sp.plot(fx, (t,0,5) ) 関数のグラフ表示 15,  52

plt.plot(mat[:,0],mat[:,3])plt.plot(mat[:,0],mat[:,3]) 行列 matmatの 0列目を x軸，3列目を y軸
とするグラフ表示

32

ax.plot_surface(X,Y,h)ax.plot_surface(X,Y,h) 3Dグラフ作成 34

sp.plotting.plot3d(h(x,y))sp.plotting.plot3d(h(x,y)) 高さ h(x,y)h(x,y)の 3D図を描画 35

print( )print( ) 印字 7

%pwd%pwd 現在のディレクトリを表示 36

np.radians(rad)np.radians(rad),  sp.rad(deg)sp.rad(deg) 度をラジアン単位にする 14,  97

np.random.randint(0,6)np.random.randint(0,6) 0～ 6までの整数の乱数発生 45

pd.read_table("dat.txt")pd.read_table("dat.txt") dat.txtdat.txtからデータ読み込み 36

x.realx.real,sp.re(x)sp.re(x) 複素数 xxの実部（npnpでは変数の後ろに .
realreal）

11,  12,  97

np.round()np.round() 四捨五入 78
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192 索 　 　 　 　 　 引

mat.rowsmat.rows,  mat.colsmat.cols matmat行列の行数，列数 30

zu.show()zu.show(),  plt.show()plt.show() 図 zuzuを表示，matplotlibmatplotlibのグラフ表示 16,  52

sp.sign()sp.sign() signsign関数 97 

sp.simplify()sp.simplify() 数式を簡略化 12,  50

np.sin()np.sin(),  sp.sin()sp.sin() sinsin関数 16,  50,  63

sp.solve()sp.solve() 方程式を解く 18,  50,  141

solve_ivp()solve_ivp() 微分方程式（時刻歴応答）を解く 56,  132

np.sqrt()np.sqrt(),  sp.sqrt()sp.sqrt() 平方根関数 9

plt.streamplot()plt.streamplot() 流線 58

f.subs(x,xin)f.subs(x,xin),  f.subs(para)f.subs(para) ffの xxに xinxinを代入，ffにパラメータ
paraparaを代入

9,  50,  93,  
159

sum()sum() 要素の合計 71

x=sp.Symbol('x')x=sp.Symbol('x')
x1,x2,x3=sp.symbols('x1,x2,x3')x1,x2,x3=sp.symbols('x1,x2,x3')

xxをシンボルとして扱う
x1x1,x2x2,x3x3をシンボルとして扱う

8,  50,  106,  
142,  178

plt.textplt.text 指定した座標に文字を表示 184

dat.to_csv('dat.xt')dat.to_csv('dat.xt') データ datdatを dat.txtとして CSV形式で
出力

38

np.transpose(mat)np.transpose(mat),  mat.Tmat.T 行列 matmatの転置行列 30,  85

type(a)type(a) 変数の型 8,  25,  36,  

dat.valuesdat.values pandaspandas classのデータ datdatを npnp classの
値に変換

37

sp.var('x')sp.var('x'),   sp.var('x1:3') sp.var('x1:3') xx,  (x1x1,x2x2,x3x3)をシンボルとして扱う 93,  141

whilewhile 繰り返し計算 45

plt.xlabel("x")plt.xlabel("x"),plt.ylabel("y")plt.ylabel("y") 図の下に "xx"，左横に "yy"を表示 17,  34

plt.xlim(0,100)plt.xlim(0,100),  plt.ylim(0,5)plt.ylim(0,5) 横軸を 0～ 100に，縦軸を 0～ 5にする 83

plt.xscale('log')plt.xscale('log')
plt.yscale('log')plt.yscale('log')

横軸を対数にする
縦軸を対数にする

83

np.zeros([n,m]),sp.zeros([n,m])np.zeros([n,m]),sp.zeros([n,m])
np.zeros([n,m],dtype=complex)np.zeros([n,m],dtype=complex)

nn行，mm列ゼロ行列作成
nn行，mm列ゼロ行列作成（複素数）

30,  47

ライブラリ 解　説 掲載ページ
import numpy as npimport numpy as np 数値演算用パッケージ 8,  45,  48,  

92,  140,  178

import matplotlib.pyplot as pltimport matplotlib.pyplot as plt グラフ表示パッケージ 8,  45,  48,  
93,  140,  178

plt.rcParams['plt.rcParams['figure..figsize'] = '] = 
(x,y)(x,y)
plt.rcParams['plt.rcParams['axes.grid'] = True'] = True

グラフの標準の大きさ (x,y)を横幅最大
10で指定，グラフに格子を標準で入れ
る

8,  45,  48,  
93,  140,  178
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193索 　 　 　 　 　 引

2.　専門用語一覧

【あ】

余り（modmod,  %%） 4,  44
安定限界 161,166
安定性 161

【い】

位相角 12
位相差，位相曲線 145
位相進み回路 149,159
位相 （平） 面  59,131
位置エネルギー 106
一巡伝達関数
　→　開ループ伝達関数 
一般解  49
一般化座標 106
一般化力 106
因数分解 19
インストール 1
インパルス応答 127,142
インパルス関数 62
インパルス振動波形 81
インピーダンス 139

【う】

宇　宙 54
運動エネルギー 106

【え】

影響係数法バランス 98
衛　星 157
円周率　np.pinp.pi,  sp.pisp.pi 8

【お】

オイラーの公式 10,13
折り返し周波数 81

【か】

カーネル 5
階　級 22,  25,  182
階乗計算 45
外　積 28
解析解 18
回転数，回転角速度 95
外　乱 157
外　力 115
外力振動（応答） 66,  67
開ループ伝達関数 156
開（ループ）特性 156, 166
加減乘除 7
重ね描き 181
加振周波数 93
加振力　→　調和加振力 93
型　typetype 25
過渡応答 126
簡単化　simplifysimplify 12, 109

【き】

規格化 85
奇関数 71
規準座標系　→　モード座標 
基本周期 70
基本周波数（成分） 68, 80
逆行列 90
求　解 50
求　根 19
共振曲線 94, 126
共振振幅（ピーク値） 95, 126
強制振動 93
行　列 26, 115
行列操作（和，差，長さ，
抽出など） 29, 30

極配置 164

虚数単位 11
虚　部 11
「距離」ベクトル D 172

【く】

偶関数 71
組立行列 31
クリホフ・ボゴリューウボ
フの解析法 129

【け】

係数行列 85
ゲイン曲線 145
ゲイン交差周波数  167
ゲイン余裕 167
減衰行列 115
減衰自由振動 92
減衰定数（係数） 106
減衰比 91

【こ】

効果ベクトル 100
高次多項式 19
剛性行列 115
　―の重畳　→　重畳 
構造化プログラム 39
高速フーリエ変換 → FFT 
交代行列 86,88
剛体ロータ 111
合同変換 89
固有角振動数 91
固有値 83,117
固有値解析 83
固有値問題 117
固有ペア 84,117
固有ベクトル 83,117
　―の直交性 86

from scipy.integrate import solve_from scipy.integrate import solve_
ivpivp

微分方程式パッケージ 93

import sympy as spimport sympy as sp 数式処理パッケージ 8,  45,  48,  
92,  140,  178

import pandas as pdimport pandas as pd 統計処理パッケージ 35
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194 索 　 　 　 　 　 引

固有モード
　→　固有ベクトル 
根軌跡 164

【さ】

最大表示周波数　fmax 81
最大値検出 46
三角波（加振） 63,67
サンプリング 75,82
サンプリング個数 80
サンプリング周期 80
サンプリング周波数 80

【し】

時間平均 69
時間窓 80
時間領域 61,80,136
磁気浮上制御系 162
軸受座標 111
時刻歴応答・時間応答 

 130,136,188
辞書　dictdict 25
実　部 11
質量（行列） 91,115
写　像 169
周期関数 69,70
集合のベン図 26
重心座標 111
自由振動 91
周波数応答 144
周波数領域 80
出力行列 115
巡回行列 46
状態変数 84
状態方程式 84
常微分 20
常微分方程式 49
初期値 49
初期値振動（応答） 66,67
自励振動 130
シンクロスコープ図 97
振幅比 145

【す】

水位（制御）系 55,138,155
数式による解析 17

数値化 8
図式解 20, 57
ステップ応答 143, 154, 175
ステップ関数 62
ストロボ図 97

【せ】

正弦半波（加振） 63, 67
静たわみ 93
積分制御動作 155
積分定数 49
絶対値 12
節　点 115
セット　setset 26
セ　ル 3, 5
セルを実行 5
全応答 66, 67
線形近似 109
線形代数方程式 31
選択 ifif文 42, 43

【そ】

相似変換 89, 90
属性定義 17

【た】

対角化 89
対角行列 29
対称行列 86
対　数 9
代数方程式 19
ダイナミックダンパ 107
ダウンロード 1
多項式展開 19
多自由度系 114
タプル　tupletuple 25
試し重り 99
単位行列 29
タンク　→　水位系 

【ち】

置換コマンド 19
地球脱出速度 59
調和加振力 93
調和関数振幅 69
重　畳 69, 115

直流成分 68
直交行列 86,89
直交条件 87
直交性 86,117,122

【つ】

ツールボタン 6

【て】

定係数の常微分方程式 49
定常振幅 136
定常偏差 155,157,176
定積分 21
ディレクトリ 35,36
データの入出力 35
テキストファイル 36
デシベル（dB） 145,178
電気回路 140
伝達関数 65,94,136,151,188

【と】

等傾斜法 130
同次微分方程式 49
動的システム 136
特殊解 49
特性根 162
特性方程式 162
特　解 49

【な】

ナイキスト線図 99,146,152
内　積 28
流れ図 40

【に】

入力行列 115

【ね】

粘性減衰係数　→　減衰定数 

【の】

のこぎり波 73,76

【は】

媒介変数 181
配　列 21

Pythonの基本.indb   194Pythonの基本.indb   194 2024/01/09   18:08:242024/01/09   18:08:24

コ
ロ
ナ
社



195索 　 　 　 　 　 引

配列操作（抽出，結合，整
形など） 23,24,29

ばね定数 91,106
バランス修正 100
反復（リピート） 39,43

【ひ】

微積分 20
非線形（係数）（項） 109,  130
非線形振動 129
左固有ベクトル 90
左半面 169
非同次微分方程式 65
微分操作 20
微分方程式 48,84,136

【ふ】

ファイルのオープン 4
フィードバック制御 153
プーリ 109
フーリエ級数展開 68,70
フーリエ係数 70
複素振幅 94,95
複素数 10
複素フーリエ係数 70
不減衰系 117
不つり合い振動（応答） 

 95,174
不定積分 21
フーリエ（振幅）スペクト
ル 71

フルビッツの安定規範 163
ふれまわり 97
ブロック線図 139
分解能 81

【へ】

平均法 129
平方根 9
閉（ループ）特性 156,173
ベクトル 27
ベクトル軌跡
　→　ナイキスト線図
ベ　ル 54
偏　角 145,178
変係数の常微分方程式 53

偏重心 98

【ほ】

ボード線図 145
ポーラ線図 183

【ま】

窓時間 71

【み】

右固有ベクトル 90
ミラー現象 79

【も】

モーダルモデル 121
モード解析 121
モード（質量，剛性，減衰）
行列 122

モード座標 118, 121, 123
モードパラメータ 118
モード分離 118
モード別伝達関数 119, 123
問題分析図 → PAD 

【ら】

ライン数 L 81
ラグランジュの方程式 105
ラプラス逆変換 61, 141
ラプラス変換 60, 136, 141
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